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Welcome to the latest edition of my monthly Final Cut Studio newsletter for November, 2007.

The goal of this newsletter is to provide information helpful to the professional user 
of Final Cut Pro. This newsletter publishes each month. Past issues are not 
archived. However, key articles are posted on my website for your reference. All 
software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. We are 
approaching 200 tutorials to help you get the most out of Final Cut!
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Reader Mail

Wrap-up

Welcome

For those of you in the U.S., I hope you had a very Happy Thanksgiving. For everyone overseas, 
I hope that November has been treating you well. Things have been very busy here - we have 
several exciting announcements coming between now and the end of the year.

KRISTI: To get started, I'm delighted to announce that Kristi Prost has joined us as Marketing 
Director. Her job is to help get the word out about our seminars, newsletters, and other activities. 
More importantly, she's interested in hearing from you about what you'd like us to be doing - 
what you'd like to learn and how you'd like to learn it. You can reach her at kristi@larryjordan.biz. 

Kristi has a strong background in marketing and video post-production, including work at CNN. I 
could not be happier to have her join us.

UK TOUR: Since last year, we've had a lot of requests, so to give you a heads up, we're bringing 
our seminars back to the UK; including presentations at Video Forum 08. We are finalizing dates 
now, but London, Birmingham, and Leeds are the cities we plan to visit. Expect details in the 
next couple of weeks — we will be traveling in early February.

FREE SHIPPING: The holidays are coming and you owe yourself a present. Take a minute and 
visit our store - the slow time over the holidays is the perfect time to polish your skills. To give 
you added incentive, we are offering free shipping anywhere in the world on all orders of $100 
or more from now till Dec. 31. 

I'm grateful for your emails and feedback - though the volume sometimes gets overwhelming, I 
learn something with every message. As I start to write this issue, I have a backlog of over 150 
emails with questions for the newsletter. Thanks for your patience - I'm getting to them as fast as 
I can.

[ Go to Top. ] 

Thoughts on Upgrading
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Since the last issue, Leopard (OS X 10.5) has been released, and QuickTime and Final Cut 
Studio have been upgraded.

I wanted to take a few minutes to talk about upgrades, since I've gotten a lot of questions about 
this recently.

Here's the basic question you need to ask yourself: "When was the last time someone 
demanded that you edit their project using the latest version of any software?"

Right. It's never happened. People ask you to edit their projects - on budget and on deadline. 
You could use linear tape-to-tape, for all they care. Your clients don't care about the process, 
they care about the results.

So, you should ask yourself: "If my clients don't care when I upgrade, when should I upgrade?"

And the answer is: not immediately after the software is released. Wait a while. I tend to suggest 
waiting about three months after a major OS release, and at least a month after a Final Cut 
Studio release. QuickTime is a very special case, which we will talk about in a minute.

Final Cut Studio does not live in a vacuum. There is more than just an operating system 
involved. Hundreds of third-party plug-ins and hardware also need to make sure they work 
properly.

Because of how Apple develops OS X, developers don't have access to the final version of the 
code until it is released. Yes, there is lots of testing prior to release, but the software continues to 
evolve and Apple has been known to change things at the last minute to fix a bug or improve 
performance. For this reason, developers can't finish testing or certifying their products on the 
new OS until it has been released.

For example, when Leopard was released, there were problems with both AJA and Blackmagic 
Design capture cards. Without question, Apple, AJA, and Blackmagic immediately started 
working to figure out what the problems were and fix them. However, those fixes take time.

When Leopard was released, Final Cut also had a variety of problems, including issues with 
Motion templates. These, too, needed time to fix.

If your goal is to run the latest version of any software as soon as it's released, then you've 
already upgraded by now. However, I would contend that the goal of most editors is to edit. To 
deliver their projects on time. Deadlines, to us, are more important than version numbers.

Also, keep in mind that Leopard adds no (as in zero) new features to Final Cut Studio. Upgrading 
the OS does not make Final Cut run any differently.

Regarding upgrading, then, here are my recommendations:

�●     Wait 2 - 3 months after a new OS is released before upgrading
�●     Wait a month after a Final Cut release before upgrading, unless your system is currently 

dead, in which case, upgrade immediately 
�●     NEVER upgrade in the middle of a project
�●     Make sure any third-party hardware and software that you rely on supports the new 

version
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NEW FINAL CUT STUDIO UPGRADES 

Apple has released two dot-release upgrades to Final Cut Studio. Both are substantial and both, 
from what I've been reading, seem stable. If you own Final Cut Studio 2, I would encourage you 
to upgrade to the latest versions as the initial release had significant stability issues; especially 
with Motion and SoundTrack Pro.

UPGRADING QUICKTIME 

Apple has also released a new version of QuickTime - 7.3. QuickTime upgrades need to be 
treated VERY carefully, as upgrades to QuickTime are driven by many different demands within 
Apple. 

QuickTime needs to support all the latest iPods and iPhones. It is the core technology behind 
iTunes and the iTunes store. It is also the foundation upon which Final Cut is built.

Because all these competing demands for QuickTime are not, necessarily, compatible, the best 
rule of thumb to follow is: if editing with Final Cut Studio is your principal reason for using that 
computer, then NEVER upgrade QuickTime beyond the version of QuicTime that is current at the 
time your version of Final Cut Studio was released.

Upgrading QuickTime out-of-sync with Final Cut is the surest way I know of to break Final Cut. 
Generally, you upgrade Final Cut and QuickTime together. When in doubt, don't upgrade 
QuickTime.

Final Cut was originally designed as a QuickTime editor -- QuickTime winds through Final Cut 
like blood winding through our arteries and veins. To upgrade one without upgrading the other is 
a recipe for system problems.

QuickTime upgrades frequently to meet the demands of all the other applications that depend 
upon it. However, if your current Final Cut system is working properly -- DON'T upgrade. Let a 
stable system remain stable, until that time when you buy the next version of Final Cut and 
upgrade everything, again, all the same time.

[ Go to Top. ] 

Larry Co-Hosts Digital Production BuZZ

During the month of November, I've had the pleasure of co-hosting the Digital Production Buzz 
podcasts with Philip Hodgetts. These weekly live broadcasts are exclusively focused on digital 
production, post-production, and distribution; with an emphasis on the small- to intermediate-
sized producer.

If you haven't heard this yet, join us every Thursday night, or visit the BuZZ website at: www.
digitalproductionbuzz.com. Their are some great guests scheduled for December.

[ Go to Top. ] 

Something New in Final Cut 6
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A couple of new goodies were almost invisbily added in a recent update to Final Cut. You now 
have the ability to show, or hide, clip names in the Timeline.

Have you every tried to set keyframes in an audio clip, only to have trouble seeing the red rubber 
band because it's blocked by the name of the clip? Well, fret no more. You can make it 
disappear!

Here's how. Click the small right-pointing arrow at the bottom of the Timeline, next to the four 
bars that determine track height. Check, or uncheck, Show Audio Clip Names, and Show 
Video Clip Names.

Very simple and handy. And really, really tucked away.

[ Go to Top. ] 

New Training Video Released - Final Cut Pro 6 - Essential Effects

The holidays are coming - which means you owe yourself a present! So, 
in conjunction with Lynda.com, I've created a new training video:  
Final Cut Pro 6 - Essential Effects.

Containing over ten hours of training, along with all the exercise files, this 
title shows you how to create professional-grade effects in Final Cut Pro 
6. This title includes:

�●     Creating text
�●     Travel mattes
�●     Importing and getting still images to move
�●     Using video generators
�●     Changing clip speed
�●     Motion effects
�●     Picture-in-picture effects
�●     Keyframes and Bezier curves
�●     Rendering
�●     Filter effects
�●     Smoothcam and Chroma-keying
�●     Nesting
�●     Composite modes
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�●     Integrating with other FCS applications

FREE SHIPPING! Just in time for the holidays (as the marketing folks like to say) we are offering 
free shipping on all orders of $100 or more. From now till Dec. 31, enter coupon code 
FreeShipping and your shipping is FREE! 

Click here to see a demo movie.

Click here to buy your own copy.

I'm back recording next week, so there will be more titles on FCP 6 coming soon!

[ Go to Top. ] 

Scopes in Final Cut

Biagio Messina began this discussion by writing:

My wife and I produce reality television. One issue we ran into in the past with 
FCP's software scopes is that they didn't register "super black" (I think) so that a 
couple eps we color corrected right in FCP using only software scopes had to be 
redone with hardware scopes....do you feel this would be the same problem with 
Color? Or do you feel the scopes in Color are more accurate and we could count 
on them? I know there's probably no substitute for a hardware scope, but we're a 
young company and just want to explore all our options.

Larry replies: I know that the video scopes (Tools > Video Scopes) in Final Cut Pro improved 
significantly with the release of Final Cut Pro 5.1.2. However, I am not an expert with Color, so I 
contacted Alexis van Hurkman. Not only has Alexis been writing an outstanding series of 
articles on Color for Edit Well, he is also the author of the Color User Manual for Apple.

Alexis replies:

First, the FCP scopes at this point do show super-black (although it's true that they 
didn't used to). You have to crank up the scope graph intensity to see more detail 
(click the little button at the upper left of the window and drag the slider to the left), 
since the default graph intensity is a little faint, but all the detail will be there.

Second, super-black levels in FCP usually get clipped as soon as you add a Color 
Corrector or Broadcast Safe filter to them (at least in version 5, I can't imagine 
they changed this in version 6). For more explanation, I discuss this in my 
"Encyclopedia of Color Correction."

Third, the Color scopes show super-black as well, down to –20 percent, and the 
default Broadcast Safe settings clip these levels by default so long as they're 
activated. However, whereas the FCP scopes now analyze every single line of the 
image (so long as the playhead is paused), the Color scopes analyze the image 
by scaling the image down internally and analyzing a reduced frame version of the 
image (there are more details in the scopes chapter of the User Manual). Because 
of the math involved, every pixel of the scaled image does contribute to Color's 
final analysis (unlike FCP's old method of skipping lines completely), and as a 
result the Color scopes very closely approximate hardware scopes. 

However, I generally say that while the Color software scopes are great for making 
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creative decisions, for true QC work, you really should have a dedicated video 
scope that's monitoring the output of your broadcast video output card. The 
reason for this is that even though Color's legalizer (in 1.0.1 and now 1.0.2) is very 
good and the Color scopes are very clear, depending on the particular 
combination of elements in any given image, various mathematically complex 
things can happen to the video signal when it goes through the encoding hardware 
of your video card, and the results can sometimes unexpectedly produce transient 
levels above where they're supposed to be. If you're not looking at the output of 
your video card, you're not seeing the whole story (for QC purposes).

Lastly, I happen to have a training DVD-ROM if you're interested, done for Magnet 
Media. I'm very happy with how it came out, and I've been getting very positive 
feedback from folks who've picked it up.

Click here to learn more about Alexis' Color training. 

Larry adds: Thanks, Alexis, for answering this! 

[ Go to Top. ] 

Picking a Codec for HD

A codec (video compressor/decompressor) is at the heart of non-linear video. It compresses the 
video to meet the specific needs of a camera, editing system, or playback device. 

There is no one "best" codec, just as there is no one "best" camera -- each is designed to meet 
different needs. However, codecs these days seem to be proliferating like rabbits. And, 
sometimes, you can't tell your players without a program (to badly mangle an old baseball joke).

This was brought home by a question Steve Denn, from WJBK in Detroit, asked:

My question is about using the Animation CODEC. Our Art Department uses the 
Animation CODEC for everything we use. It has proven to be the cleanest looking 
CODEC for our 720X486 videos.

Now that we are moving into the big world of HD they made us an Open that is 
1280 x 720 30 fps, using the Animation CODEC. I matched the sequence to the 
clip. It plays fine in the Canvas and displays on our 30-inch HD Samsung monitor 
via AJA's breakout box, but as a still image only. So I posted my question and got 
a response back from Philip Hodgetts, who wrote: 

Use a codec FCP likes. Animation and Video are not all I-frame and 
will never play successfully in an FCP timeline even if the settings 
match. DVCPRO HD, ProRes 422, Uncompressed or Photo-JPEG 
will work. Animation, Cinepac, Video et al will not work and require 
rendering before playback.

So what do I do?

Larry replies: Philip is correct. Some codecs are designed for data transfer at high quality, such 
as the Animation codec, while others are designed for real-time playback, such as ProRes 422 or 
Uncompressed video. 

The easiest workflow for your organization is to have the art department continue creating 
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materials using the Animation codec. It has great quality, and a known workflow. Then, bring 
those Animation files into Final Cut and edit them to a ProRes 422 timeline. This workflow means 
that your art department doesn't need to do anything new, while ProRes provides you with real-
time playback and great quality. 

You'll need to experiment to decide whether you prefer the look of ProRes 422 or ProRes 422 
HQ. My suspicion is that ProRes 422 will be sufficient.

[ Go to Top. ]

Faster Ways to Display Timecode

Robbert-Jan van der Does and Nick Meyers both wrote in with the same comment. (The 
following is from Robbert-Jan.) 

I'm always looking forward to read your newsletter and Edit Well. Good job!

[Regarding your article on creating burned-in timecode for a sequence ] I have a 
tip to suggest as well. If you add it to a slug, just as you described, but instead of 
changing the composite mode to screen, you can crop the slug in a way that you 
only see the timecode in a small rectangle. Then you can also change the opacity 
of the slug to have it semi transparent on top of the video. Most of the times it will 
save you a render.

Larry replies: Robbert-Jan, thanks for writing. Yes, cropping an image is almost always real-time, 
rather than using the composite mode. However, the composite mode will allow you to see the 
image under the numbers, while the black background will block it.

Both work, use the option that seems best for your project.

[ Go to Top. ] 

New Filter from Spherico

Thinking about timecode, Andreas Kiel, of Spherico, wrote to tell me about a new filter he's 
created for Final Cut: TCR Plus. 

It's a simple-to-use utility which allows a better and faster way for review and approval of cuts. It 
combines FCP's XML power and a FCP plugin filter to display timecode more efficiently with 
greater options, including labels, colors, and displaying reel IDs.

Here's a link to learn more: http://www.spherico.com/filmtools/

[ Go to Top. ] 

Having Problems Following Larry's Advice
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While we are on the subject of timecode, Eric Freudenburg, of Norfolk, Nebraska, writes:

Larry, i read your article on adding timecode with interest. So, I followed the steps 
just as you had mentioned and I got the timecode to show up over-laid fine and it 
counted correctly. It was all good but the length of the slug was too short for my 12 
minute sequence. Ok I thought there is a fix for this. I went to the User 
Preferences and changed my Still/Freeze Duration. I made a new slug and 
dragged it to the timeline and it showed up, BUT it was the same length as the 
original 2 Minutes as originally marked in the User preferences menu. I double 
checked my Still/Freeze Duration and it was as I typed to the new length of the 
sequence. I tried dragging the the ends of the clip to increase the duration, I tried 
the "right click and change duration" neither one worked.

So the problem I have is not with the timecode working but getting the slug to the 
correct duration. I don't know if there is a time limit on how long the sequence can 
be or if my FCP version just doesn't support it correctly. I am using FCP version 
4.5. I don't know what to do. HELP!

Larry replies: Eric, the problem is you are using Final Cut HD. In FCP version 5 and later, the 
length of your slug is determined by the settings in Final Cut Pro > User Preferences > Editing 
tab. I just successfully created a 15 minute slug.

But, with FCP HD, you can't. You have to duplicate the clips to fill out the sequence. The 
problem is that FCP HD's timecode generator resets when the clip restarts. In other words, you 
can't get there from here....

So, here's the workaround: create a separate sequence filled with black slugs that's slightly 
longer than your current sequence.

Output it as a self-contained quicktime movie, then reimport it into your FCP project. Use that 
instead of the black slugs and things should work fine.

[ Eric reported back later that this worked perfectly. ]

[ Go to Top. ] 

Looping Playback - or Not

Chas Arthur, from Powell, Wyoming, writes:

Have a question I was hoping you could help me out with. Final Cut automatically 
loops when we get to the end of the project starts back to the beginning of the 
timeline again. Can you set something up so it doesn't do this? We've looked all 
over.
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Larry replies: Yup. The answer is View > Loop playback.

If you want to turn looping off, uncheck it. To turn it on, check it. It will loop either from the In to 
the Out, or from beginning to end of a sequence.

[ Go to Top. ] 

Linking Unrelated Audio and Video Clips

This subject came up recently in a Final Cut discussion group. Let's say you have an audio clip 
recorded on one device, and a video clip recorded on another - often the case in double-system 
film production or music video. The audio and video are in sync - but the clips, once captured, 
are not related to each other. 

Note: There are actually two ways to do this - see the update below. 

Final Cut makes this easy with a process called merging clips. In fact, you don't even need the 
timecode of the two clips to match. What you DO need, however, is some method of aligning 
them in the timeline so they play in sync, then tying them together to make them act as though 
they were one clip.

This is actually a two-step process: 

1.  align the clips
2.  then link the clips.

To align the video and audio, edit both to the timeline. Then, while playing back both clips, select 
the audio and press comma (,) or period (.) to move it one frame left, or right, in the timeline 
until they align.

Then, select both clips and select Modify > Link. Both clips will now act as though they were 
captured together in sync.
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You can either leave them on the Timeline, or, if you want to use them more than once, drag 
your linked clip back up to the Browser, where it will act link any other clip.

UPDATE - Nov. 27

Tom Wolsky writes:

There are two separate functions. One called merging clips, which lets you merge 
video and audio based on TC or edit points, and there's a another function called 
linking, which lets you link video and audio of disparate files in the timeline.

Larry replies: My fault. You are correct. This describes linking clips. To merge a clip, you use 
Modify > Merge clip. Clips need to be synchronized using either a common In, Out, Timecode, 
Auxilliary Timecode 1, or Aux Timecode 2. Apple's manual goes into this in some detail starting 
on page 45 of volume two. You can merge clipes either in the Timeline or Browser. 

[ Go to Top. ] 

Something Else New in Final Cut Pro 6

Two new zoom commands have been added to Final Cut Pro 6: Zoom In on Playhead in 
Timeline, and Zoom Out on Playhead in Timeline.

However, they were not assigned keyboard shortcuts.

You can find them by going to Tools > Button List and typing "on playhead" in the search box.

These are two really helpful functions, so I've added them to my standard keyboard shortcuts by 
assigned them Control+Shift+= (equal sign) to zoom in and Control+Shift+- (hyphen) to zoom 
out. 

This allows my zoom keys to all be variations of hyphen and equals:

Zoom in in active window: Cmd + = 
Zoom out in active window: Cmd + -

Zoom into Timeline: Option + = 
Zoom out of Timeline: Option + -

Zoom in on playhead: Control + Option + = 
Zoom out on playhead: Control + Option + -

[ Go to Top. ] 
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Saving Files for DVD Studio Pro

Dave Steward writes:

I know how important it is to save only video files on the second drive and 
everything else on the system drive. But what about other apps? Should I save 
DVD Studio Pro projects and its materials on the system drive or the 2nd drive. 
Same thing with Livetype, After effects, Motion, etc...

Larry replies: Dave, it all depends upon whether the files play in real-time. If you need real-time 
playback, it is good practice to store the files to your second drive. If you don't need real-time 
playback, they can be stored anywhere.

In the case of your question, I make it a practice, though it is not required, to store all data files 
on my second drive. With DVD Studio Pro, I put group all similar assets in one folder, then store 
all the individual folders into a single folder for importing into DVD SP. This simplifies 
organization and importing. 

I generally store project files in a DVD Project folder on my boot drive because project folders in 
DVD SP, like Final Cut, never contain any data; just pointers to the data.

[ Go to Top. ] 

New Release of Veescope Lite

Brad Wright wrote to tell me about the latest release of Veescope Live:

Veescope Live provides real-time chroma keying, high and low video brightness 
Zebra patterns all being performed on your graphics card of your computer from a 
live video source. In addition, Veescope Live works with any Quicktime video input 
source, such as a DV FireWire stream, or a high-definition capture card. In 
addition, Veescope Live can display a waveform or vector scope directly on top of 
the video. 

You can learn more at: http://www.veescope.com. It retails for $100.

[ Go to Top. ] 

More, Yes More, on Still Images

Of all the issues I get questions on, none are more frustrating than dealing with still images. So, 
returning us again to the issue that refuses to die, Chris Roberts writes:

I wonder if you can assist with a bit of a discussion I've been involved with on our 
user group emailing list. I remember when you gave your seminars here at the 
beginning of the year, there was some discussion about videos sizes and using 
anamorphic video in iDVD. At the time you recommended the best way to 
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overcome this issue is to use QT Pro to resize the display size of the video, but 
changing the height not the width of the video, even though anamorphic images 
would normally be stretched horizontally. I hope I have this right.

Is it possible for you to just briefly describe why we should change the vertical size 
of the movies, rather than their width?

Larry replies: Chris, both NTSC and PAL use rectangular pixels to describe their images. The 
computer uses a square image. The shape of the pixel is it's "aspect ratio," that is the ratio of the 
length compared to height. 

Computers have an aspect ratio of 1 (1:1), the length and the height of the pixel are identical.

By default, we describe the height of a pixel as being equal to one. That means that the width of 
the pixel varies, depending upon format. For example, NTSC has an aspect ratio of 1:0.906. PAL 
has an aspect ratio of 1:1.06. Neither format is square, and both use differently-shaped 
rectangles; NTSC is tall and thin, while PAL is short and fat. The picture above illustrates this. 

To get these images to look good on a computer monitor, say, when we export them as still 
frames for print or web use, we need to convert the aspect ratio from rectangular to square. This 
means adjusting the width of an image, because the height is always, by default, set to the 
correct length.

Just in case you were hoping that this issue goes away with HD, disappointment looms in your 
future, DVCPRO-HD, HDV, XDCAM-HD, and HDCAM all use rectangular pixels.

[ Go to Top. ] 

Video Business Advisor Newsletter

I've been talking with Steve Yankee, who runs Video Business Advisor, over the last several 
months and I just realized I've not mentioned him to you. His website is the place to learn low-
cost money-making advertising, marketing and promotional strategies for your video production 
business that you can easily implement and maintain.

So, if you want to learn more about how to run your business, visit his website at: www.
videobusinessadvisor.com. He also has a regular business newsletter that's absolutely worth 
subscribing to.

[ Go to Top. ] 

HDV White Paper
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Sony has published a very hard to find white paper on the HDV format. (Thanks to Jonathan 
Tyrell for tracking this down.) Note: This link downloadsa PDF, I found that it takes a while. 

http://bssc.sel.sony.com/BroadcastandBusiness/minisites/HDV/images/HDV_whitepaper.pdf

[ Go to Top. ] 

Motion Tracking

Karla Hutton writes:

Help! Larry I need you to post a Motion 3 tutorial to Lynda.com! I need to use the 
Motion tracker feature and the online manual is greek to me. I am just not getting 
it. Any quick suggestions?

Larry replies: Thanks for writing, Karla. We're planning to cover the Motion Tracker in the next 
issue of Edit Well.

[ Go to Top. ] 

Coming Up in Edit Well

Speaking of Edit Well, this next issue is jam-packed with interesting goodies!

�●     Mark Spencer returns with the first of a three-parter on understanding and using Motion 
3's new 3D camera.

�●     Alexis Van Hurkman is unstoppable in his efforts to explain how mere mortals can use 
color, this time with a presentation on the Color FX room.

�●     Chris Summers has two articles on automating compression and file transfers as part of 
your approval workflow, along with a new perspective on how the web can improve your 
client review and approval process.

�●     I've got an article on why bit depth matters, along with a summary of what you need to 
know about Leopard and Final Cut Studio.

Plus, we have more audio interviews and video tutorials on Final Cut Pro 6. 

To learn more, or subscribe, visit: www.peachpit.com/editwell.

[ Go to Top. ] 

Interview Guests Needed

I'm looking for editors to interview for Edit Well. 

One of the truly fascinating tasks in assembling Edit Well are our audio interviews with editors 

http://www.larryjordan.biz/nxltrs/nxltr_40.html (14 of 32) [12/26/07 6:32:46 PM]

http://bssc.sel.sony.com/BroadcastandBusiness/minisites/HDV/images/HDV_whitepaper.pdf
http://www.peachpit.com/editwell
http://www.peachpit.com/editwell


Larry Jordan's Monthly Newsletter - #40 - Nov. 2007

around the world. Recently, I've spoken with a Canadian educator who teaches Final Cut to 
elementary school children, an musician/editor who assembles videos for their fans while 
traveling in their tour bus from one city to the next, and an editor who assembles documentaries 
for the History and Discovery channels.

What fascinates me is how all these folks are using Final Cut in such divergent ways, yet we all 
are wrestling with the same challenges; how do we capture and maintain the attention of an 
audience.

If you haven't listened to these Edit Well interviews yet, you are missing a treat.

If you would like to be interviewed, please send us an email. We create three new interviews a 
month and I'd love to share your story with the world.

[ Go to Top. ] 

Organizing for a Massive Project

Tim Wilson writes:

Please tell me where I can find your most complete advice about organizing a 
*massive* editing project -- close on 200 hours of material that has to be sugared 
down to 1 hour. I don't mean your excellent basic instructions on setting up media 
vs project/non-timecode files, but more detailed suggestions about what works for 
you when doing a project of this size, e.g. breaking reels down into subclips and 
organizing those.

At present, we have the 200 HDV tapes captured in 10 min. segments and 
arranged by bins, each named according to the individual reels. My plan is to 
leave those 200 bins untouched, but to make subclips of selected material, and 
put those subclips into either or both of:

1.  Another set of bins named by theme or type (principal interview/scenics/B-
roll etc/), and

2.  A *long* timeline that would rough-assemble all main sequences of the film

Does this make sense?

The Final Cut project file and all media would then be shipped to our Editor for her 
to screen only the Selects, and go from there.

As usual, any help as usual is much appreciated!

Larry replies: Tim, your basic approach makes sense. However, keep two things in mind:

1.  Final Cut tends to slow down when you have thousands of clips in the Browser. 
Minimizing the number of Browser clips you need is a good idea.

2.  Final Cut allocates RAM memory based on the number of clips in the timeline. FCP 6 
supports up to 12 hours of material in one sequence, but if that is made of lots of small 
clips, you will see a performance slow-down.

If anyone else has suggestions on how to manage large projects, please let me know and I'll 
share them with everyone.
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UPDATE - Nov. 27

Tom Wolsky writes:

I would recommend Shane Ross's DVD on organizing material in FCP projects.

Shane Ross wrote in to suggest the same thing: 

I have a tutorial DVD on this and many other organizational tips. I believe I gave 
you a copy. GETTING ORGANIZED WITH FINAL CUT PRO.

http://training.creativecow.net/dvd_store/get_organized_fcp/get_organized_fcp.
html

Brandon Klein writes:

Great newsletter!

We are in the final stages of editing down approx 320 hours to 80-90 minutes. The 
project file for all the footage- 25,000 clips is 138.3MB, and takes FCP 10 minutes 
just to open on the latest hardware. I feel the pain of your readers question. 

This may be a very simplistic answer, but working with sub clips turned out to be a 
nightmare for us and we stopped using them very quickly. (In out points- dragged 
to the timeline for the editor to watch real rough cuts worked considerably better) 

We divided the 25,000 clips by content type so that each file was between 10MB 
and 20MB. These were easily manageable. 

We then did rough cuts of each category and were able to bring those timelines 
over to a new project to create the final timeline. We would often have 2-3 projects 
open (the original content type projects) at a time so we could access some of the 
raw footage if needed- but always work on a timeline that was in a different project 
file all by itself. 

Having these smaller content project files also allowed more than one editor to 
work on different parts of the film simultaneously over the network. 

Perhaps too simple, but effective nonetheless. 

Larry replies: Thanks for letting us know. Also, Russell Stiggants sent in a long reply, which I'll 
put in the next issue. 

[ Go to Top. ] 

Overwrite Editing Directly to Tape

Bob Lutjen, of the City of Port St. Lucie, Florida, writes:

I have to record long meetings at City Hall. Quite often i will have a DVCAM tape 
with a 3 hour meeting on it and i will need to insert a couple of seconds of video at 
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different spots throughout the meeting.

Does anyone know the steps to do this? The deck I am using is a Sony DSR-25. I 
have tried following the steps in the FCP manual but it has proved to be absolutely 
useless.

Larry replies: Bob, do you "insert" in Final Cut terms, or "insert" in videotape terms. To insert as 
Final Cut defines it means to insert new video and slide everything that follows it later on the 
tape. That is not possible.

If you mean to add a new shot to the tape, thereby replacing what was on the tape at that point 
previously, then it is possible.

Bob replies: 

Sorry for the miscommunication. I'm trying to avoid having to spend many hours 
digitizing footage and then dumping it back to tape. What I'm trying to do is a three 
point edit by setting an IN point in the timeline and an IN & OUT point on my deck.

Larry replies: Oh! This is possible, but deck-specific. You would use the Edit-to-Tape function in 
Final Cut to set an In and Out on the tape, then do an Insert edit to put whatever you have on 
Final Cut's timeline into that portion of the tape.

However, low-end decks (both DV and Beta) do not support insert editing. This is something 
manufacturers do to differentiate their decks.

What you need to do is find a deck that supports inserting. For instance, in DV, the Sony DSR-
1500 does, but the DSR-25 does not. In Betacam, the UVW series does not, but the PVW series 
does.

You many need to take your project to a post-house that has the necessary hardware.

[ Go to Top. ] 

8 mm Follow-up

A couple newsletters ago I presented a question from a reader about capturing 8 mm film. Thad 
Mack wrote in with a better suggestion than mine:

There is another solution to the 8 mm/Super8 mm film transfer question. Reel 
Transfers, LLP, a sister company of ours (www.reeltransfershome.com ) transfers 
this film all the time. They use a Bosch FDL 60 Digital scanner custom-modified 
for 8 mm and Super8 (one of only two in the country, if not the world). The FDL 60 
has exposure and color-correction controls that are manned by a colorist who 
transfers the material to DVD, DV or (very rarely anymore) VHS and other tape 
formats, with or without music. 

Depending on format, the Bosch handles optical or mag track audio. Since it 
scans the film instead of using a film gate, film with damaged sprocket holes can 
be transferred. The film is cleaned, if necessary, using a Lipsner-Smith cleaner 
like that used for feature films. They handle film from all over the country. And the 
Bosch FDL 60 can be configured for 16mm and 35 mm, as well.
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Contact Carl Strahl at 215-953-9499 or reeltransfers@verizon.net. Web site: www.
reeltransfershome.com

Larry replies: Thad, thanks for letting us know.

[ Go to Top. ] 

More on MS Microphones 

Recently, this newsletter carried a discussion on Final Cut's support for MS microphones. Alain 
Pelchat sent in the following:

I just went through the news letter and reading about MS recording. Being a Logic 
user I found it surprising that there would be no support for it in Soundtrack pro 
since there it exists in Logic. So I checked it out, and Soundtrack pro had 
supported MS decoding from the beginning. Just add a "Direction mixer" in the 
inserts from the "Imaging" group. In the upper right corner, the little check box with 
MS is right there :)

Larry replies: Alain, thanks for sending this!

[ Go to Top. ] 

Thoughts on Shooting 24 fps

Recently, I wrote an editorial on shooting 24 fps material. Basically, I said that shooting 24 fps 
has less an effect on the look of your video than the lighting and lens filters you use.

Martin Corley responded:

Too true! 24p is a fashion statement. 
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Film and Video each have a unique look. Make your selection based on your 
budget, or whatever yardstick you choose. And then light it!... 

The ProMist filter is a good idea too. 

Larry replies: Martin, thanks for writing! 

Since we were talking about 24 fps, Andrew Wilson, of Westview Digital Video & Design, added:

I completely agree with your opinion on shooting 24p 'because someone told you 
it looks better'. Go buy a filter and do better lighting. Right on!

One question, since 99% of my production work is seen on SD TV's, I still use all 
SD settings and shoot with an XL2. The only reason I would think of upgrading 
now to HD is to future-proof my productions (I've been thinking of Panasonic's P2 
500 camera).

I hear a lot about the different standards of HD; 720p vs 1080i vs 1080p but I can't 
think of what the proposed frame rates are of those standards. So I agree with you 
about shooting in the format that most people are watching but what are your 
thoughts on shooting in HD to future proof your footage - and what settings do you 
think will do the best job at that?

Larry replies: "Future-proofing" is a VERY slippery concept. If I had the choice, I'd shoot 
1080p/60. That gives you a progressive frame with the flexibility to downconvert to any frame 
size and frame rate. 

However, those cameras are not cheap. 

Current HD frame rates are variations of 23.98, 24, 25 29.97, 30, 59.94, and 60. Sheesh...! It 
was easier when we just cranked film cameras by hand!

[ Go to Top. ] 

Reader Mail
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�●     Quick Photoshop Tip
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�●     Anti-Virus Software 
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�●     Looking to Make a Transition 
�●     Problems with Video Tapes 

[ Go to Top. ] 

QUICK PHOTOSHOP TIP 

Billy Miller provides the following PhotoShop/FCP tip:

I don't know if this has been mentioned...

Open an image from the Timeline into Photoshop by control+clicking a clip and 
selecting Open in Editor. (I often do this to add Gaussian Blur to remove moiré.)

Save the image to move it back into Final Cut, but keep the image open in 
Photoshop.

Return to Final Cut to look at the changes and if you don't like them, move the clip 
back to Photoshop using Open in Editor. To remove your changes in Photoshop 
go back in time in the History palette.

Save again and look at the results. Repeat until you are happy.

Larry replies: Billy, Apple calls this technique "round-tripping," and it's excellent. Keep in mind 
that you MUST always use Open in Editor each time you send a file to Photoshop. Otherwise, 
when you save the file in Photoshop, it will break the link and Final Cut will display the file as off-
line.

[ Go to Top. ] 

MEASURING DURATIONS 

Robert Rhines writes:

I frequently find myself trying to figure out how long a blank space is between clips 
on the time line and also how long a clip is in the time line I need to replace. I 
thought I saw you do this a time or two in your training, but can't seem to find it. 
What's the quick secret?

Larry replies: Robert, to determine the duration of a clip, select it and type Control+D.

http://www.larryjordan.biz/nxltrs/nxltr_40.html (20 of 32) [12/26/07 6:32:46 PM]



Larry Jordan's Monthly Newsletter - #40 - Nov. 2007

To determine the duration of a gap, control+click it and select Fill with Slug.

Then, control+click the slug and read the Duration on the fifth line down. (You can also control
+click a clip to read the duration, but then, I wouldn't have been able to tell you about Control+D.)

Another way to find the duration of a clip is to put your playhead in the middle of the clip you 
want to measure and press X. This sets an In and an Out for that clip. You can then see the 
duration in the timecode box in the upper-left of the Canvas. 

[ Go to Top. ] 

PICKING THE BEST FORMAT 

Kim Barry Brunhuber, somewhere in Sierra Leone, writes:

My question is a basic one.

I'm a news reporter by trade, and I make low-budget independent documentaries 
by night. For years I've been shooting with my Panasonic DVX100 at 24p. Right 
now I'm in Sierra Leone, and this is my problem:

I'm shooting two "projects" simultaneously; I'm shooting individual news pieces to 
be played on the national news, and I'm also shooting a doc about some 
journalists in Sierra Leone. Now I had been shooting everything at 24p 
Advanced... this is what I've been doing for years. But the news folks think (quite 
rightly) my footage looks a bit funny, as news is normally not shot at 24p. The 
obvious solution would be to shoot news at 29.97 and shoot the doc at 24pA. The 
problem is, I'm shooting b-roll for both projects and I don't want to shoot everything 
twice!

This is the basic question. Is there a way to shoot the project in one format, let's 
say, shoot everything 24 Advanced, then capturing that footage with either the 
Advanced pull-down removal for the doc or using normal NTSC capture for the 
doc, OR shoot everything at 24 fps Normal and then capture at normal NTSC, or 
is there another solution?

Larry replies: Kim, thanks for writing. If there was one "magic format" we would all be shooting in 
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it. Unfortunately, as many of us are discovering as we move to HD, the world is a highly 
incompatible place.

Since it is easier to go from 24 fps to 29.97 fps than it is to go from 29.97 to 24, I would 
recommend you shoot everything at 24 fps Advanced.

Then, for your documentary, capture the footage using Final Cut's pull-down removal into a 24 
fps sequence. For the news, RE-capture the same footage at 29.97. This way, while you will 
need to capture twice, you'll only need to shoot once.

[ Go to Top. ] 

SELF-CONTAINED VERSUS REFERENCE QUICKTIME MOVIES 

Alex Pushkin writes:

Larry, I have a bunch of .mov files that I exported from Final Cut. How can I 
determine if they're self-contained or not?

Larry replies: Alex, a self-contained DV movie is about 200 MB per minute, a reference movie is 
about 10 MB per minute. Checking file size will tell you immediately.

UPDATE - Nov. 27

Michael Grenadier and 

strong>Tom Wolsky both wrote into to say:

Michael: Kinda wrong, Larry. A reference movie will contain renders of any 
unrendered material and so a reference movie can be as large as a selfcontained 
qt, if it the entire sequence requires rendering and is unrendered at the time of 
export. 

Tom: This only works if you render before exporting. 

Larry replies: Sigh... OK, well, you're both right. It was an elegant solution, just not a sufficient 
one. Thanks 

[ Go to Top. ] 

SO MANY QUESTIONS, SO LITTLE TIME 

Glen Miller writes:

OK, so I've got about a zillion questions, but here's the one I need right now:

Within Final Cut - I've been given a project where some of the narration tracks 
were recorded mono. Some were on the left channel of a stereo track. How do I 
turn the left track into a mono track?
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Larry replies: Piece of cake.

If it's a stereo clip, with the audio on the left channel and the right channel is blank, you could just 
adjust the panning for the clip in the Viewer. 

What I would do, however, is first delete the unnecessary audio channel:

1.  Edit the clip from the Browser to the Timeline
2.  Select the clip
3.  Uncheck Modify > Stereo Pair (or press Option + L)
4.  Click the unneeded track to select it in the Timeline 
5.  Delete the selected track
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Then, double-click the remaining track to load it to the Viewer and drag the Pan control to 0, 
which centers the audio for the clip. (You could also just type "0" into the Pan entry box, but how 
much fun is that?)

Drag the small hand from the upper right corner of the Viewer to the Browser to store your 
corrected clip in the Browser, then edit normally as needed.

[ Go to Top. ] 

PLAYING HD VIDEO IN iDVD 

Gary Schwartz writes:

I’ve been trying for the past four hours to get HD video to play full size in IDVD. I 
export from Final Cut as a QuickTime Video using current settings as you 
suggested, but it didn’t work when I dropped the video into IDVD! 
 
Any suggestion isappreciated.

Larry replies: Gary, the problem is that iDVD doesn't support HD video. It needs to convert it 
from HD to SD, which means you don't get to see the HD picture you created. This is not 
necessarily the fault of iDVD - it's the fault of two incompatible DVD standards for HD: HD-DVD 
and Blu-Ray. 

These two standards each require different DVD burners and, generally, different software. 
Currently, DVD Studio Pro supports creating DVDs using HD-DVD, but the default Macintosh 
DVD burner does not support burning either Blu-Ray or HD-DVD disks.
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Unless you are creating DVDs that will be replicated in the tens of thousands, DVDs are not yet 
ready for HD. 

[ Go to Top. ] 

UPDATING AND MAINTAINING 

Michael D. writes:

I have a question. I just updated my friend's father's computer from 10.3.9 to 
10.4.3 but now when the computer boots up it makes you login and it didn't do that 
before. I went through the preferences and couldn't find anything to set it to auto 
login without password. 

One other thing, I was trying to remember what it was that you were suppose to do 
to maximize performance. I held down the option key as the computer was starting 
up just as the grey screen began, but it didn't do anything and I'm just afraid to try 
it over since I don't know if it's the correct thing to do. 

Larry replies: Michael, first, the current version of OS X is 10.4.11. You've updated the computer 
to a fairly old version of the OS. I'd suggest bringing it even more up-to-date. (As a note, I 
recommend always downloading operating system updates directly from Apple's Support > 
Downloads web page, rather than using Software Update. Software Update is more convenient, 
but downloading the entire file is more reliable/effective.)

Second, you set auto-login in Blue Apple > Auto-login > Accounts:

�●     In the Accounts, click the lock in the lower left to unlock the account.
�●     Click the Login options just above the lock
�●     Check the Automatically log-in check box

Regarding the secret start-up key, once you've installed the update and restarted the computer, 
restart it again holding the SHIFT key down for 30 seconds after the spinning gear first appears. 
Then, when your computer finishes starting up, restart it again holding no keys down.

[ Go to Top. ] 
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WORKING WITH AVCHD

Ted Petit, of Video West Productions, writes:

I have recently stumbled onto a program called "Voltaic". This allows the 
user to take AVCHD footage and convert it to a Quick Time movie. From what I 
can tell it uses the Apple Intermediate Codec. The cost is $30.00.

I have purchased this program and have used it to convert .mts files that were 
produced by a Sony HDR-SR5 camcorder.

I have read various Blogs comparing the conversion of .mts files with FCP 6 and it 
was stated that the entire file structure of the [AVCHD] footage has to be provided 
in order for FCP 6 to work with it. With Voltaic only the .mts file is necessary.

Of course you are taking a hit with the 4:2:0 vs 4:2:2 sampling...but for an 
intermediate step what is your opinion? .... and have you used/tested this 
program?

Larry replies: Ted, Final Cut only started supporting AVCHD with the 6.0.1 release and it, like 
Voltaic, converts it into the Apple Intermediate Codec.

AVCHD, like HDV, uses very limited color sampling (4:2:0) combined with a highly compressed 
file format (GOP-based H.264). However, I have not worked with this format and would be 
interested in comments on this format from other readers...

[ Go to Top. ] 

CREATING A TELEPHONE AUDIO EFFECT 

Trent Anderson writes:

In FCP or Soundtrack, how might I make a voice sound like it is on a telephone 
call, what filter might work?

Larry replies: Trent, thanks for writing, it was good meeting you at our seminar in San Francisco!

This effect is simple, and can be done in either Final Cut or Soundtrack. It requires using two 
filters:

�●     Apply a Low-pass filter to your audio clip, set the frequency to 2500 and Q = 1
�●     Apply a High-pass filter to the same clip with the frequency set to 500 and Q = 1

It will play in real-time and sounds perfectly convincing.

UPDATE - Nov. 27

Ben Balser writes:
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Your current issue (I love this newsletter) has a letter from Trent Anderson about 
how to get the telephone effect. 

In STP 2, if you apply Process > Effects > EQ > Channel EQ, there are several 
presets that will get you started on very nice telephone (or 2-way radio) sound 
effects. In the control window of that effect go to Show Presets > 07 EQ Tools. In 
that category there are: Megaphone EQ, Phone Filter Notch, Phone Filter Wide 
Band, and Telephone EQ.

I've been finding these very good places to get that effect from. If any is not 
perfect for what you personally want, simply apply the one that is a closest match, 
tweak the controls (never be afraid to experiment with these filter controls), once 
you have what you want, you can add it as your own User Preset for future 
reference, or to apply to other sound clips in the same FCP project. It makes 
getting the telephone/radio effect much faster and easier and better sounding. 
Even for an old sound guy like me who can do it manually in my sleep. Gotta love 
them Presets in STP!

Larry replies: Thanks, this is another way to do the same thing. 

[ Go to Top. ] 

MISSING SOUNDTRACK PRO FILES 

Tomas Lovén, from Sweden, write:

We recorded 3h 30 min audio into Soundtrack Pro, version 2.01. The file was 
about 3.6 Gb before it disappeared. My Mac Book Pro has 2 GB RAM.

Before I started the recording I saved the project using Version 1. When I tried to 
save the file after after the recording, the computer crashed after about saving 
50% of the file. I tried various ways to save this, but, at the end, I only had an 
empty file.

Is there any chance to bring back that file. What should I have done instead?

Larry replies: Tomas, I'm very sorry about the crash. Here are a couple of ideas. First, create the 
initial project file using Version 2, rather than Version 1 of STP. There are major differences 
between the two versions.

Second, be sure you have the latest version of Soundtrack Pro (2.0.2 as of this writing). The 
initial release was not particularly stable.

Third, and perhaps best, when ever Soundtrack Pro records a file it automatically saves it to disk 
during the recording process. Perhaps all you lost was the project file, not the actual audio itself.
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There are two types of work files: scratch/record files and edited media. To see where these are 
stored, go to the Soundtrack Pro > Preferences > General tab. In the bottom of the dialog, are 
the path names indicating where these files are stored. 

Open every file there, as they often have quite cryptic file names, and see what's there. With 
luck, you'll find the file you lost.

[ Go to Top. ] 

AUDIO SPEED CHANGES IN SOUNDTRACK PRO 

Carl Whitney writes: 

I have a problem recording analog and digital audio into Soundtrack Pro. When I 
do this the Timeline plays back at a different speed. I tried doing this back in 
February for an Indie Movie I edited. I ended up using Pro Tools.

Larry replies: First, make sure you are using the latest version of Soundtrack Pro.

Second, Soundtrack Pro allows you to set the sample rate of the timeline between a variety of 
settings. Without knowing more about your problem, my first guess is that you have a sample 
rate mismatch.
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There are two places to set sample rates: in the Timeline and Preferences.

The Timeline controls what sample rate is used for playback of all Timeline clips. It is initially set 
based upon Preferences but can be changed at will.

The Soundtrack Pro > Preferences > Project tab controls the presets for a Timeline. 

By default, STP sets everything to a 48 kHz sample rate. My guess is that your two clips used 
wildly divergent sample rates which caused the problem.
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A REALLY HARD QUESTION 

Erik Scheel, from Tanglewood Productions, writes:

The owner of the studio has a customized bars and tone and, of course, wants to 
use them.

So what I want to know: Can you somehow change the preferences in FCP to set 
the bars and tone, as ours, in the print-to-video dialog box? I know you can 
manually set the black, slate, countdown but you cannot set the bars and tone 
FCP just puts it there for you.

If you have any ideas I would love to here them!

Larry replies: Erik, you can't change Final Cut's default settings for color bars. Nor can you have 
it point to a different set of bars instead of what it creates internally for the Print-to-Video dialog.

However, it is easy to import whatever bars you want to use and edit them to the timeline prior to 
output.

Just be sure the bars you are importing are accurate - otherwise, it sort of spoils why you put 
bars at the beginning of the sequence in the first place.

[ Go to Top. ] 

ANTI-VIRUS SOFTWARE 

MJ Godges writes:

Is there an anti-virus software you prefer on the Mac?

Larry replies: No. In fact, if you are doing video editing, anti-virus software will make things much 
worse. I have mine turned off. 

[ Go to Top. ] 

LOOKING TO MAKE A TRANSITION 

Charlie Wilson, from the BBC - Washington, writes:

What would be a good plug-in set for transitions that are neat but not over the top. 
I am not interested in treating the video, so I don't need Magic Bullet, but just 
something to extend the set built into Final Cut.

Larry replies: There are lots of good choices - it all depends upon your definition of "not over the 
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top." Check into:

�●     FX Factory
�●     GenArts
�●     Digital Film Tools
�●     Boris Continuum

[ Go to Top. ] 

PROBLEMS WITH VIDEO TAPES 

Joan York sent in the following:

The yellow "clean cassette" icon started flashing with my old Sony VX2000. After 
getting it repaired, twice, I finally gave up and bought a new Sony PD-170. Very 
nice! Except, starting with the second shoot, the yellow "clean cassette" icon 
started flashing, again! Holly mackerel!!! 

I then started to think it was the tapes. I am using the Panasonic MQ's. When I 
think of it, it wasn't long after I changed tapes that I started to have this problem. I 
got in touch with my supplier and ordered the older Panasonic PQ's because the 
MQ's were discontinued. I shot with them the next wedding and didn't have a 
problem.

I have been talking with the Panasonic rep. I will be sending him the tapes I've had 
problems with for inspection. Have you heard this from anyone else?

Larry replies: What I've learned is that you want to stick with one brand of tape. All tape wears 
heads. However, different tape wears heads differently. Especially with older cameras, changing 
tape stock no longer matches the existing wear patterns and you start to get errors and drop outs.

Once you find a tape you like - stay with it. Both you and your camera will be happier.

[ Go to Top. ] 

Wrap-up

Well, I still have over 40 emails in the backlog list, but we are getting closer to getting caught up...

In the meantime, please continue sending me your comments and questions. I love hearing from 
you and enjoy the conversations that develop around these stories.

Also, please take a few minutes, visit our store and buy something. The holidays are coming and 
you owe yourself a present. Your support for our seminars and products keeps our website, and 
this newsletter, free. 

Thanks for all your comments and questions. I love hearing from you because when you share 
your ideas and suggestions, we all learn.
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Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    

 

[ Click here for a printer-friendly PDF version of this issue. 600 KB ]

Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends 
to sign up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list 
is not sold, rented, or bartered. The only person who knows you are on this list is 
me.

The information in this newsletter is believed to be accurate at the time of 
publication. However, due to the variety of possible system and software 
configurations, the author assumes no liability in case things go wrong. Please use 
your best judgment in applying these ideas.

The opinions expressed in this newsletter are solely those of the author. This 
newsletter has not been reviewed or sanctioned by Apple or any other third party. 
All trademarks are the property of their respective owners and are mentioned here 
for editorial purposes only.

Text copyright 2007 by Larry Jordan & Associates, Inc. All rights reserved. This 
newsletter may not be reproduced or published in any way, in whole or in part, 
without specific written permission from the author. 

Links to my home page or articles are welcome and don't require prior permission. 
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